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 Overview 
 

Actual Systems is proud to bring you the latest version of Pinnacle Professional.  There are a 

number of new ways to customize your usage of the software, including the ability to add freight, 

core, and other surcharges automatically by Part Type. 

 

Some Highly-Requested Features Now Available: 

 Determine the order in which Alternate Items will display 

 New Customer entries go through a Duplicate Check 

 Over-Payments to Workorders are now prevented 

 Updates and Enhancements to the eBay module 

 

The Big update included here is a restructured Purchase Orders module.  Credit POs can now be 

made directly from the original PO.  Pickups or Deliveries are also created within the PO screen 

itself, mirroring the popular RMA module.  Modifications to the Shipping module make POs, 

Credits, and RMAs more obvious throughout the receiving and return process. 

 

In Section I, you will find a guide to the details of New and Expanded Features.  Section II 

covers the smaller updates found throughout the system.  Finally, you can have your employees 

resume their Java Updates again.   
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 Section I:  New & Expanded Features 

 

Changes to the Find Parts Layout 

The Find Parts screen has been modified and now contains a series of tabs similar to the Control 

Center or the order screen. Each search option is now a tab or panel that can be moved into a 

customized layout. For example, you can move the Part Code-IC Search to show on the screen 

at the same time as the Part Search (standard search using the command line): 

 
 

The list of part codes has been changed as well to allow you to toggle between finding parts via 

part code or by part name. For any parts list, right-click on the columns or the  button to 

access the options to select parts by part code or by part name. When Select by Grouping is 

selected, you will be able to select the part using part codes (i.e. selecting the part category then 

the part type, for example ―AA‖ for engine). To view the category/type letter designations, select 

Use P1 Shortcodes. When Select by Name is selected, you can search for a part simply by 

typing the name. Part names can be customized using the Item Aliases feature (see below). 

 

 
 

Right-click in this area to toggle 

between selecting by part code and 

selecting by part name 
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The change affects every part list in Pinnacle, including the Text Search, the Single Part Input 

screen, and reports like the T4. For more on using the part name search, see the Expanded Text 

Search section below.  

 

Changes to the Purchase Orders module  

 New Shortcut Key:  F7 – Find PO by PO Number 

 Credit PO now linked – ―Credit‖ button on PO Screen 

 Schedule Pickup / Delivery directly from PO Screen 

 Description now saves in order history when paying POs 

 

Creating a credit PO is simple. Open the PO, then click the Credit button (if the button is grayed 

out, hit Save, then OK). A new screen will come up for the credit PO, where you can enter all 

the necessary information. To create a pick-up for the credit PO, save the credit PO and then 

click Pickup. 

 

Because credit POs are now linked, there are perhaps a couple procedural changes in and around 

the PO process. Here’s a basic summary/review of the entire PO process: 

 

1. The workorder/PO gets created.
1
 

2. When the brokered part arrives, open the PO and mark it as received and complete.
2
 

Note: it is highly recommended to verify the vendor and cost match the vendor invoice at 

this point. After this point in the process, there are a couple scenarios where the entire 

order must be credited and rebilled in order to correct vendor/cost information. See the 

following sections for more details. 

3. The order then gets processed, invoiced, and delivered to your customer. 

4. If at some point the customer returns the part, you can create a RMA (if necessary) to 

pick up the part, then credit the invoice when the part comes in. You can also credit the 

PO and place the credit PO on a route to deliver back to the vendor as necessary.  

5. When the vendor statement arrives the following month, the statement can be reconciled 

using the Find Purchase Order screen to identify which POs from a given vendor match 

the statement. POs matching the statement can be marked as payable.
3
 

6. Once the statement is reconciled, mark the POs as paid in the Pay PO screen. At this 

point you can apply any outstanding vendor credits (i.e. credits from previously paid 

POs).
4
 

7. Use the P10 alongside the S10 report to determine the profitability of the brokered sales 

for a given time period. A general list of POs can be generated by using Find Purchase 

Orders or the P3 report. 

 

                                                      
1
 The PO will default to an Unordered status. Mark the PO as Ordered by opening the PO and 

adding a date into the Ordered field. 
2
 Open the PO, click the Receive button, enter a date, click OK, and then Save. Complete the PO 

by checking the Complete box; click Save. 
3
 This can be done using the Mark as Payable button located in the upper left-hand corner of the screen of the Find 

Purchase Orders screen. Note: at present this action cannot be undone. Please see Paying POs below for further 

details. 
4
 Highlight the credit PO and the PO you wish to pay and click the Allocate button. 
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Voiding versus Crediting POs. Voiding POs should only be done if the parts are not received. 

If the parts have been received, the PO should be credited, not voided.  

 

If the part is has not come in yet and the customer cancels, the vendor cannot provide, or for any 

other reason, there are several options to void the PO: 

1. Cancel the workorder using the Kill button in the order screen. 

2. remove PO from workorder using the Remove button in the order screen 

3. Use the Search For Replacement Parts under the Items menu in the order screen to 

replace the old PO. 

4. Use the Void button in  the PO screen. 

 

Once the parts comes in but is bad, was en route to be delivered when the customer cancelled, or 

for any other reason, the PO should still be received in Pinnacle and then credited. There a 

couple scenarios that may play out from this point: 

1. If replacing the part with one from another yard: 

a. Receive and complete the PO (you did receive it after all). 

b. Credit the PO and place on a route to delivery back to vendor, if necessary. 

c. Open the workorder and use Search for Replacement Parts to create a new PO 

for the replacement part. 

2. If cancelling the order (i.e. a lost sale) 

a. Receive and complete the PO (you did receive it after all). 

b. Credit the PO and place on a route to delivery back to vendor, if necessary. 

 

If the part was received and invoiced, but needs to be returned, the general process is as follows: 

1. Create an RMA, if necessary, to pick up the part from the customer. 

2. When part comes back, receive the RMA (if necessary) and credit the invoice. 

3. Credit the PO and put the credit PO on route to deliver to vendor (if necessary). 

 

Paying POs. The process of paying POs is essentially unchanged. POs can be marked as payable 

from the PO screen (while saving) or from the Find Purchase Orders screen. When POs are 

marked as payable, they will then appear in the Pay PO screen, where the POs can then be 

marked as paid. Single POs can be paid using the Receive and Allocate buttons (similar to 

paying invoices, receive the payment, highlight the desired orders, and click Allocate). You can 

pay a group of POs using the Block Payment option. Highlight the group of POs you wish to 

pay then click Block Payment. The dialog will show you the dollar amount of what has been 

selected. In either case, enter your check number and any other notes in the Description field and 

these notes will be added automatically to the PO order history.  

 

Tracking credits for paid POs can now be done through the Pay PO screen. If a credit PO is 

created for an unpaid PO, the credit will simply reduce the amount owed in the Pay PO screen. If 

a credit PO is written for a paid PO, then the credit PO will show in Payments portion of the 

Pay PO screen to be allocated to another PO.
5
 

 

                                                      
5
 As of this writing, this feature does have full functionality. If a PO was credited and then marked as payable, the 

credit will need to be manually allocated. This is a known issue that will be addressed in a future build. 
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If a PO is Marked as Payable in error. Unfortunately this action cannot be undone (i.e. you 

cannot remove a payable date and therefore cannot ―unmark‖ a PO from being payable). If a PO 

is marked as payable in error: 

1. If simply premature, the best option is to simply wait until the PO shows on the next 

vendor statement (no harm, no foul). However  

2. If the PO was marked as payable and an issue has occurred with the order since, there are 

two options: 

a. Crediting the PO in full will remove it from the Pay PO screen (and may have 

occurred in the natural course of things).  

b. Use a Payment Adjustment to clear on the errant PO and make comments in the 

PO order history. When the PO is ready to be made payable, create a PO 

Adjustment and note the PO number the PO represents in the Description field. 

 

If a PO is paid in error, at present, the only way to fix the issue is to create a PO Adjustment. It 

is also advisable to note in the PO history that the PO was improperly paid and when the PO was 

actually paid (proper pay date, comments will need to be entered manually on the PO). This is a 

known issue that will be rectified in a future build 

 

Fixing POs. POs are now read-only (i.e. cannot be edited) if a credit has been created. Thus, if 

information incorrect on the PO: 

● if the PO has been not been completed, all information can be edited (including Vendor, 

VIN, and cost) 

● if the PO has been completed and NOT credited, you can use the Undo Complete button 

to make changes. 

● if the PO has been credited, no more changes can be made. 

 

Since no changes can be made to the PO if it has been credited, it is highly advisable to put 

processes in place to verify the information on the PO before it is completed or credited (similar 

to converting workorders into invoices, all the information should be correct on the PO before 

completing the PO). 

 

To fix POs that have been credited: 

1. If the PO was credited in full, there is ―no harm no foul‖ as there is $0 due. You can 

make comments on PO/order history if desired to clarify the information that was wrong.  

2. If the PO was partially credited, and you need to change the vendor or VIN on the PO: 

a. Credit the PO the rest of the way. 

b. Credit the invoice in full 

c. Rebill the invoice and PO with the corrected information.  

3. If the PO was partially credited and you need to change the cost:  

a. If changing the cost to a lower cost, simply credit the PO further 

b. If changing the cost to a higher cost, the entire order must be credited in full (i.e. 

the remaining amount on the credit PO and the invoice) and re-billed (invoice and 

PO) for the proper amounts. 

 

If a credit PO was written for an incorrect amount: 

1. If the original credit amount was too little, simply credit the PO further. 
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2. If the original credit was too much, the entire order must be credited in full (i.e. the 

remaining amount on the credit PO and the invoice) and the entire order must be credited 

in full (i.e. the remaining amount on the credit PO and the invoice) and re-billed and re-

credited (both the invoice and the PO) for the proper amounts. 

 

Purchase Order Profitability. There is a new report for determining profitability on brokered 

sales—the P10 Purchase Order Profit Report (Purchase Orders > Reports). This report is 

purpose-built and meant to be ran alongside the S10 report when determining profitability on 

POs. The report is quite simple, showing PO by PO what the profit and mark up is, then totaling 

the net profit and averaging the profit and mark up percentages. 

 

 
 

The first thing to keep in mind is that POs show on this report based on the invoice date. This is 

necessary to be able to match the report to the S10. Thus, for a given date range, the report will 

show all POs that have been invoiced (this means that misc POs will NOT show on the P10 

report). A PO with a $0 cost and only a credit amount implies that the original invoice/PO 

occurred before the date range for the report, but the credit occurred inside the date range. Also 

note the Credit PO and Credit Amnt columns reports the subtotal of all credits for the date 

range, as an order/PO can have multiple credits. The % Profit is derived by dividing actual profit 

by cost: 

(Act. Profit)/(Cost – Credit PO) 

The % Mark Up is strictly the amount the part was marked up (from the cost) at the time of 

invoicing (does not consider PO or invoice credits): 

(Invoice Amt. – Cost)/Cost 

Site for each order is based on the invoice site (again, matching to the S10), so if an invoice/PO 

is written in Site 1 but the credit PO was written in Site 2, when running the P10, the credit will 

show for Site 1 because that is the site of the invoice. 

 

When matching to the S10, the report must be run by user. The Net Invoice Sales on the P10 

will match the Brokered Sales column of the S10. The totals line of the P10 will total the Act. 

Profit for each sales person, indicating the profitability for  the brokered items for that time 

period, however, you can also take Net Invoice Sales - Net PO Cost to see the numbers that 

comprise the Act. Profit total. 
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Determine the order in which Alternate Items will display  

The order of Alternate Items on workorders will now match the sort order in the search results 

screen (set in the Preferences). To adjust the sort order, go to Management > Preference 

Editor, filter for ―sort‖, double-click on the field under the Value column, and then click on the 

>> button. Click-and-hold to drag items to the desired position in the sort order or use the 

buttons found to the right. When finished, click the >> button, then click in the field under the 

Name column. The click Save. 

 

Duplicate check when adding a new customer  

When entering a customer into the system, Pinnacle will check for possible duplicate entries and 

allow you to select a current customer proceed with creating a new customer. The duplicate 

check will automatically activate when data has been entered in at least three fields (including 

the state field, which is automatically populated). If Pinnacle identifies possible duplicates, a 

dialog box will appear listing all potential duplicate customers, the closest matches appearing at 

the top. The list defaults to showing non-hidden customers; to show hidden customers, right-

click anywhere on the list and check the box to Show Hidden. Highlight a line to display the 

customer information in the bottom half of the dialog box. You can use the mouse or the arrow 

keys to navigate through the list. Then choose from the following options: 

● If the customer is found to already exist, highlight the line in the upper half and click Yes 

to proceed using that customer. 

● If the customer does not already exist, hit No to create a new customer entry. 

● Click Cancel to exit 

 

Item Aliases 

You can now create custom aliases for the Item Type field in the Text Search. To create a custom 

alias go to Inventory > Utilites > Item Alias Definition. The Aliases list shows a list of all part 

types and their aliases (together in one list). Highlight on an alias and the available aliases for 

that part will show on the right-hand side of the screen under the Associated Aliases for item 

Type window: 

● To find an alias, highlight any alias from the list on the left and start typing. A search 

filter at the upper left will appear showing what you are filtering for. 

● To edit an alias, highlight the alias from the list, click Edit at the bottom of the screen. 

You can edit either the alias or the part associated with that alias. When finished, click 

OK.  
● To add an alias, highlight one of the aliases for the part you wish to add an alias to, click 

on Add at the bottom of the screen. Verify the part you wish to add this alias to, input the 

desired alias, and click OK. 

● To remove an alias, highlight the alias you wish to delete and click Remove. The alias 

will be highlighted in red with the word REMOVED next to it.  

 

NOTE: the aliases only apply to the part lists only—they do NOT show up in areas such as 

Custom PDR, URGnet, or workorders/invoices. 

 

All changes to item aliases are recorded and can be viewed in the Log Viewer (Management > 

Utilities > Log Viewer). 

 

 



 Page 10 of 21 

Automatically Add Surcharges by Part Type 

Pinnacle now has the ability to automatically attach surcharges to part types.  The surcharges can 

be either a flat rate or a percentage. A prompt will appear in the Order Wizard when creating 

orders to confirm the surcharge or can be edited at that point if desired. To assign a surcharge to 

a part type: 

1. Go to Management > Utilities > Service Charges.  

2. Filter and select the part type from the list on the left side of the screen. 

3. Check the box next to the surcharges you want to automatically add to orders.  

a. To add a flat dollar amount, simply type the amount in the box to the right of the 

surcharge.  

b. To add a percentage, type in the percentage amount followed by a percent-sign in 

the box to the right of the surcharge (e.g. type ―10%‖).   

4. Hit Enter when finished and then click Save.  

 

Additional Option for Core Charges 

Core charges can additionally be automatically added based on interchange number.  To set up: 

1. Verify Core is set to automatically add via Management > Utilites > Services Charges 

(see above).  Set a default amount here that applies to the majority of your core charges. 

2. Go to Inventory > Manual Pricing by Part Type. Search for the interchange or group 

of interchanges you want to specify a different core charge (i.e. a core charge other than 

the default you set in step 1). When finished hit Manual Pricing. 

3. In the Manual Pricing screen, hit Edit to activate the fields at the bottom of the Screen. 

4. In the Core field, enter the core charge amount you wish this interchange to default to 

when your sales people create orders.  The amount here will override the amount set in 

the Service Charges screen (see above).
6
 

5. When finished hit Save. 

To set an interchange back to the default level, enter ―0.00‖ in the Core field in Manual Pricing. 

 

Expanded options for finding orders  

The Find Parts (Sales > Find Parts) and Modify Part (Inventory > Modify Part) screens have 

a new option to find orders by the search options in those screens. Using any of the available 

search options, select the part, interchange, stock number, etc… and then go to Actions > Find 

Orders.  TIP: stay on the keyboard by hitting Alt + n then f after entering your search criteria in 

one of the available search options.  

● You have the option of viewing Quotes, Workorders, or Invoices/Credits by selecting 

the corresponding tab.  

● To further filter the list, highlight one of the orders in the list of results and start typing. 

You will see a blue box in the upper right-hand corner of the screen. The highlighting 

will move to the first order that matches what you typed; use the arrow keys to navigate 

to other orders that match your filter criteria. The filter is by exact match only (though is 

not case-sensitive). TIP: Use the * character whenever a space proceeds your filter 

criteria. For example, you want to find an order for John Smith by filtering for “smith”, 

simply type “*smith”. 

                                                      
6The Core field now serves a double-purpose: first, as a price level when inventorying a core 

part and second, as the core surcharge amount when selling the given part-type/interchange.  
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● The number of results is based on the preference Number of days of orders when 

searching orders by part. The default is 90 days. 

 

There is also a new field in the Find Orders screen (Sales > Find Orders) named Item Text. 

Enter a part name in this field (for example ―engine‖ or ―transmission‖) along with your other 

search criteria to limit your search results to orders that have a part that matches the name in the 

Item Text field. 

 

Order Wizard 
There are several new prompts now available in the Order Wizard: 

● Delivery Address (when one present on the customer record).  

● Ship Type 

○ If Customer Pickup is selected, the next prompt will be for Expected Date (i.e. 

work order due date) 

○ if Delivery or Ship is selected, the next prompts will be for the route and the 

delivery date (will also prompt for WO Expected Date depending on 

preferences).  

● Type of Sale 

● PO Expected Date. Note: filling in the Expected Date does not automatically fill an 

ordered date into the PO--they still need to be marked as ordered by opening the PO and 

entering a date in the Ordered field. 

 

When entering the Expected Date, the format is MM/DD/YY, so for February 1
st
, 2011, type 

―02/01/11‖ to enter the date. When entering the Expected Time, the format is military time 

(HH:MM). The colon will automatically populate so you just need to enter the four-digit number. 

For PM times, simply add 12 to the time. For example, to enter an Expected Time of 3:00pm, 

type ―1500‖ to get 15:00 (3+12 =15). 

 

These prompts can be turned on and off on a per user basis by going to Management > Utilites 

> Order Wizard and checking/unchecking the desired Order Wizard prompts. 

 

There are also several preferences that affect the Order Wizard. To access these preferences go to 

Management > Preference Editor > type ―wizard‖ in the text filter. There is only one new 

preference, but to recap all the different options: 

● (NEW) Force the user to select a Delivery Address in the Order Wizard. If checked,  

forces users to have a delivery address selected before proceeding in the Order Wizard. 

● Order Wizard: Show requested model if unknown. If checked, an prompt will appear 

in the Order Wizard asking the use to specify a model name when no model was 

specified in the part search (for example when searching by Hollander Code-

Interchange). 

● Order Wizard: Show item cost for brokered parts. If checked, Pro will always prompt 

for the item cost when creating POs with the Order Wizard, regardless of what users have 

set under their personal Order Wizard Settings. 

● Order Wizard: Select the default warranty by part type. If checked, Pro will bypass 

the prompt to select a warranty if there is no default warranty for the part type.  
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Require Customer PO# for Certain Customers 

There is a new checkbox in the Customer Screen, Required PO Number. If checked, 

workorders and invoices cannot be saved if the Customer PO# field in the Invoice tab of the 

order screen is blank. When converting quotes to a workorder, a prompt will appear immediately 

after checking the Workorder box to enter the Customer PO#. Note: this does NOT apply to 

the Order Wizard. Users will be able to leave the Customer PO# field blank in the Order 

Wizard; they will however be prompted for the number when saving the order. 

 

Expanded Text Search  

The Text search has been expanded to include searching by multiple years and multiple parts. To 

navigate through the Text search: 

 From the Start Year, type the two-digit year and hit the [Tab] key 

 The End Year will default to the Start Year, hit [Tab] to move on; otherwise enter the 

desired two-digit End Year and then hit [Tab] to proceed 

 Begin typing the model, hit [Tab] once the model you wish is highlighted 

 When selecting parts:  

- Start typing and you will see the list begin to filter to your part, when you are 

highlighted on the correct part hit the [Esc] key or the [Enter] key, then hit the [space 

bar] to select the part (the part is selected once the check mark appears).  

- To un-select a part, simply hit the [space bar] (the check mark will be removed).  

- When finished selecting all your parts, hit the [Tab] key 

 Use the arrow keys to navigate to the correct interchange, hit [Tab] to move to the next 

interchange (will need to hit [Tab] twice to get to the next interchange). 

 If searching for mulitple models, hit Alt + d, then Alt + a to get back to the start year to 

add a different search 

Tips 

 Use Alt + a to get to the start year 

 can also hit [Tab][Tab] to get down to the start 

 Right-click on the ―...‖ and choose Select by Name to find parts using the part name or 

alias, choose Select by Grouping to find parts via the part code 

 Shift + [Tab] will take you back one field 

 

Using the Text search with Part Search 

To limited degree, the text search can also be used with the Part Search (i.e. the standard search 

using the command line). It is perhaps easiest to explain by example. Let’s say you are trying to 

look up an 07 Focus radio but are unsure of the part code or are having trouble finding it, you 

can alternatively search by name by doing the following: 

1. Type ―07 focus‖ in the command line 

2. Right-click in the columns above the command line and choose Select by Name 

3. Single-click any part to highlight it 

4. Type ―radio‖, the list will immediately highlight the radio part. Hit the space-bar to select 

it (i.e. place a check mark in the box next to the part name). 

From here you can continue using the mouse to select the interchange and perform your search. 

When in the Part Search tab, the text option does NOT work with the command line (i.e. you 

cannot type ―07 focus radio‖ in the command line) and can only be used to look up single parts. 
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Q1 Customer Quotes  

The purpose of this report is to show what customers and what business types are getting quoted 

and how many of those quotes turn into sales (i.e. invoices). The Q1 report in Pro has more detail 

than the Classic version of the report. Access the report by navigating to Management > 

Request Reports > Q1 Customer Quotes. Here are a few important things to keep in mind with 

this report: 

 

● The actual part sold may not be the part quoted, as parts can be swapped out. However, 

the intention of the report is to track how often you are able to close quotes for a given 

customer, not to track what specific parts are being quoted/sold to what customers (that 

would be a different report). 

● The report period is used to select quotes by their created date. If a sale or credit from 

these quotes occurs outside the report period, the sales or credits are included in the 

report.  This means that the sales and credits on the report can change depending on 

when the report is run. 

● The sales details on the report for each customer refer only to sales that have been made 

from a quote. If the sale comes from a workorder only, no initial quote, it will not appear 

on this report. 

● The customer on the report is the customer on the last version of the quote. If the 

customer is changed in the workorder and invoiced, the final customer the parts are sold 

to will be different to the customer shown on this report.  However, the Q1 report will 

show these as sales to the quoted customer. (NOTE: Another report would be needed to 

show both the customer quoted and sold to, as quotes to one customer could be sold to 

several different final customers - showing this is beyond the scope of this report.) 

● For the purposes of this report, a converted quote is a quote that was eventually 

converted to an invoice (not simply converted to a workorder). 

● The Quoted total includes parts and charges.   

 

Field breakdown on the report 

Customer –customer as of the last version of the quote 

Customer type –business type of the customer  

Num quote—number of quotes created for this customer 

Num parts—number of parts that were quoted 

Quoted total—the total amount quoted, includes parts and charges, excludes tax 

Avg part quote price –the average part price quoted, part price less any discount, excludes tax 

Num conv—number of quotes that were converted to invoices, is also the number of invoices 

Parts sold—the number of parts sold 

Conv rate—(Num  quote / Num conv) * 100 

Invoice total—total invoiced from the quotes, includes parts and all charges, excludes tax 

Avg part sale price—average sale price of the parts after taking off discount  

Net sales—(Invoice Total - Credit Total) 

Credit rate—(Credit Total / Invoice Total) * 100 

Num credit—number of credits against invoices created from the quotes 

Credit total—the total amount credited, includes part and all charges, excludes tax 

Num restk—the number of parts that were restocked 

Num Fcred—the number of parts that were fully credited 
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S30 Sales by Month  
This report will itemize your sales on a month-to-month basis. It can be run for either your whole 

company, a single site, or for a single salesperson.  To access the report, navigate to 

Management > Sales Reports > S30 Sales by Month. The report will break down your sales 

into the following areas:  

● Inventory 

● Extra 

● Inventory + Extra sales (subtotal)  

● Core (sales of core status parts) 

● Brokered 

● New 

● Warranty 

● Freight 

● Complete Vehicle 

● Labor 

● Core Deposits 

● Other Surcharges (all remaining surcharges) .  

Clicking the Show Monthly Percentages option will list each percentage (by month) for each 

area. Choosing the Sales by Month Chart under the View field will generate the report as a bar 

graph. 

 

Control Center Additions 

● Ship type  (i.e. Counter Sale, Customer Pickup, Delivery, Ship) for each order can now 

be displayed in following tabs: Unconfirmed Work Order, Work Orders over 2 days 

old, Ready to Invoice, and Today’s Invoice’s/Credits. Right-click on a column header 

and check the box next to Delivery Method. The ship types display as follows: 

- C = Counter Sale 

- P = Customer Pickup 

- D = Delivery 

- S = Ship 

● Part statuses for all parts on the order can now be displayed in the following tabs: 

Unconfirmed Work Order, Work Orders over 2 days old, Ready to Invoice, and 

Today’s Invoice’s/Credits. Right-click on a column header and check the box next to 

Part Status. The part statuses will display as follows: 

- I = Inventoried 

- D = In Dismantling 

- W = Warehouse 

- U = Unbolted 

- Y = Yard Bolted 

- R = Extra sale 

- B = Brokered 

- N = New 

- C = Core

● The route for an order can now be displayed in the Ready to Invoice tab. Right-click on 

a column header and check the box next to Delivery Route. 

● Who Deleted and Delete Reason have now been added to the Today’s Deleted 

Inventory tab. 
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 Section II:  Other Enhancements & Fixes 
 

 

Accounting Module 

 

● Improved performance of how statements generate 

● Statements now appear in alphabetical order, regardless of capitalization 

 

Delivery Module 

 

● You can now reorder items on the manifest by click-and-drag. NOTE: after releasing 

the item to its new position there will be a slight delay as the list reorders. 

● You can now filter for (view) specific routes in Confirm Deliveries and Delivery 

Maintenance
7
.  Select the route(s) you wish to see from the drop-down field in the 

upper-right of the screen. The settings will apply to both the Confirm Deliveries and 

Delivery Maintenance screens simultaneously (i.e. changes to one will apply to the 

other). Settings save automatically. TIP: print a list of the items in any tab for a single 

route by filtering for that route, then right-click in the tab and choose Print Table. 

● Customer RO# and Customer PO# now print on the manifest. TIP: to update the 

Customer RO# or the Customer PO#, open the invoice and go to File > Customer 

Reference. Both the invoices and the manifest can be reprinted to reflect the changes.
8
 

 

eBay Module 

 

● The Part History tab in the eBay Listing Manager now remembers its layout. 

● Improved handling of error messages returned from eBay. 

● Due to changes in listing requirements from eBay requiring a return policy, a new tab, 

Returns Policy, has been added to the eBay Lister screen. The return policy settings are 

saved per part type. TIP: if you do not see the Returns Policy screen, right-click in a 

white area of the screen, go to Show View > Returns Policy. 

● Fixed the issue where if the preference Lock Parts in Pro when listed on eBay was 

checked, the parts would stay locked even after the listing ended. This is no longer the 

case; if the listing ends, the part will no longer be locked in the search results screen. 

● Fixed issues where at times items sold in Pinnacle would not ending the eBay listing. 

● Fixed issue where parts sold on eBay would not created orders in Pinnacle if the 

customer address was outside the United States (e.g. Puerto Rico). 

 

 

 

 

 

                                                      
7If routes do not appear in when first accessing Confirm Deliveries, simply close and re-open 

Confirm Deliveries and routes should appear. If orders/invoices are not appearing, verify you 

have the route selected. 
8manifest can be reprinted by going to Shipping > Driver Panel, select the manifest under 

Available Manifests and click Reprint Manifest. 
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Inventory Module. 

 

● The Reason Details are now included on the report when using the Print List option in 

Resolve Parts. 

● Visible dates on sub-assembly parts can now be edited en masse. There are two options to 

achieve this: 

- Globally (i.e. for occurences of a sub-assembly part at once). Go to Inventory > 

Utilities > Define Assemblies. Hit the key to the left of the master part to display the 

sub-assembly parts. Click in the Delay Days field and change the delay days as 

desired and hit Enter. Then go to Actions > Update Existing Assemblies. All 

occurences of the selected sub-assembly will have their visible date adjusted 

accordingly from their respective inventory date (NOTE: if the change results in a 

visible date in the past, the visible date will not be updated). All global changes to the 

visible date are tracked and can be accessed through the Log Viewer, under 

Management > Utilities > Log Viewers, choose Assembly from the Log Type field. 

- Adjust all sub-assembly parts on a single master part at once. Bring up the master 

part(s) you wish to edit in Modify Part. Highlight the part (single-click), then go to 

Sub-Assemblies > Update Visible Date on Sub-Assembly Parts. Select the date 

you wish the sub-assembly parts to be visible in inventory and click OK. 

● Sub-assembly parts can now be detached while the master part is on a workorder, but 

must be done through the order screen. Open the order, highlight the part, then go to Edit 

> Edit Part, go to the Sub-Assembly tab, highlight the parts you which to detach and 

click Detach Parts 

● Brokered parts will now display the PO number as the stock number in the following 

areas: the Workorder Manager, the printed workorder, the delivery tag, the part report, 

and the Parts Puller Detail report.  

● In the Enter PDR Parts screen, the Reload button has been removed from the toolbar. It 

can still be found under the Options menu.  

● When printing the list in the Workorder Manager, time now shows in the Expected 

Date column. 

● In the Workorder Manager, the Hide brokered parts not received check box was 

clearing whenever a pre-defined search was selected, though the filter remained active. 

This has been changed so that the check box remembers the settings at the time pre-

defined search was saved. 

● Added Bad Transmission to the list of damage codes available in the Detail tab of the 

MVR. 

● Added Write Off to the list of damage codes available in the Detail tab of the MVR. 

 The following improvements were made to alternate indexes: 

- Now save when selected in a part record. 

- Print on the Prescribed Parts tag styles 

- On a misc PO, only vendor-specific alternate indexes will be availabe from the drop 

down options (PO must be saved first). Otherwise, all available alternate indexes will 

display.  

- New alternate indexes can be created when receiving misc POs. Simply type the new 

alternate index in the field before saving the PO with the Add to Inventory box 

checked. 
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● Fixed errors from using the filter when generating PDRs for a vehicle with a VIN less 

than eight characters. However, as a result of the fix, VIN filtering will no longer work 

when the VIN is less than eight characters. NOTE: Pinnacle requires seventeen 

characters to decode the VIN. 

● Fixed errors when filtering for upper control arms in the Parts tab of the MVR screen 

● Year and model now show for alternate items on the Part Report in the Workorder 

Manager. 

 

Management Module 

 

● If you have multi-site operation with three or more sites, reports can now be run for any 

combination of sites. Note: as of this writing this change has only been implemented on 

the following reports: A11, S10, S10a, S30, T7, Jim Counts (JC) Part Sales by Quarts, JC 

Sales by Part Age. 

● New Preference. Add quick customers to phonebook by default. When using the Add 

Quick Customer feature: 

- With preference checked, the Show in phonebook box defaults to being checked 

(creates a non-hidden entry). 

- With preference unchecked, the Show in phonebook box defaults to being 

unchecked (creates a hidden entry) 

● New Preference. Add quick deliveries to phonebook by default.  When using the Add 

Quick Delivery feature: 

- When checked,  the Show in phonebook box defaults to being checked (adds a 

delivery address to the customer) 

- When unchecked, the Show in phonebook box defaults to being unchecked (creates 

a one-time delivery address for the order) 

● New Preference. Automatically allocate credits to invoice refunds 

- When checked, for unpaid invoices that have been on a statement, credits will 

automatically allocate to the original invoice 

- When unchecked, for unpaid invoices that have been on a statement, credits will 

remain outstanding until manually allocated (can be allocated to any invoice). 

● New Preference. Allow tags to be printed for unbolted parts on restock. With this 

preference checked, you will be able to print tags for U-status parts when restocking, but 

not print tags for U-status parts when running the dismantling report. 

 

Sales Module 

 

● Private comments can now be added to remote workorders. When creating a remote 

workorder, before saving the order click on WO to PO comment, type the comment and 

hit OK. This must be done before the workorder/PO is saved for the first time (i.e. at the 

time the workorder is created). Comments cannot be sent to the remote workorder after 

the PO in the originating yard has been saved for the first time. 

● Able to once again change the user on the quote or workorder before the order is saved 

for the first time. After the order is saved, the ability to change the user on the order is 

based on the security setting. 

● Quotes now show a history entry when the system expires the quotes automatically. 

Based on the preference Number of days until new Quotes Expire, the system will 
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cancel the quote when the number of days indicated in this preference is up, and the 

following message will show in the order history: 

2011-03-09 00:01:00 admin Cancelled order 213564 / 1: Quote Expired Quote Expired 

● Payment receipts for pre-payments on workorders can now be printed directly from the 

order screen. From the order screen, go to the Order History tab, double-click one of the 

history lines showing a payment was taken, a pop-up will appear, select the payment you 

wish to reprint and click OK. 

● Eden Locates now show only Wholesale and Retail prices (standard prices no longer 

show). 

● Enter key now works to perform all searchs (including the Part Code-IC search) in 

Find Parts. 

● Tabs in the order screen can no longer be closed, they can only be minimized, with one 

exception—the Delivery Details, Route Selector, and Delivery Selector in the Shipping 

tab can still be closed. 

● Credits can now be manually posted to other invoices rather than the original invoice. 

The option only pertains to unpaid invoices that have been on at least one statement and 

is activated by a preference (see below). NOTE: please use caution when turning this 

feature on as it means all charge credits must be manually posted if the invoice has been 

on a statement. 

● When restocking parts that were sold from I, D, U, or Y statuses, the location field will 

be grayed out and the vehicle location will be displayed.  To locate the part to a location 

separate from the vehicle, check Set Status to W, the location field will activate and you 

can locate the part to the correct location. 

● The status column of the Alternate Items dialog box will now display N for new parts and 

C for core status parts (previously displayed W, U, or Y for all parts). 

● Removed users no longer appear in the list of available names when receiving RMAs. 

● Additional Credit Reasons have been added into the system: 

- Not Happy With Quality 

- Invoice Keying Error 

- Short Supply 

- Exchange Item Return 

- Not Picked Up at Counter 

- Other 

● Payment history on invoices now shows the date the payment was received (previously 

showed the date the payment was allocated to the invoice). 

● Changes to the Engine No. in the MVR will now be reflected on past invoices, which can 

be reprinted showing the correct Engine No.  

● Fixed an issue where you could not cancel the RMA with a pickup. 

● Over-payments on pre-paid workorders are now restricted. If overpaying a workorder, 

users will see the following message: 
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 The Order History will now show rollback and refund as they apply to pre-payments on 

workorders. NOTE: if  the Sale Type is change on order (e.g. from COD to Cash), a series of 

extra transactions will show up in the order history and in the accouting ledger (the A2 

report). This is a technical necessity to ensure Pinnacle records the money in the correct sale 

type and to track all the activity on the order. The S11 will not be affected, however. 

 

PinPad 

 

● The Vehicle tab in the bid screen contains a new field: Fluff. Enter the dollar amount of 

miscellaneous sales you expect off the vehicle you are bidding on. The Fluff amount will 

be included when PinPad calculates the recommended bid in the Parts tab. Note: the Tot. 

parts amount in the bid screen will NOT include the Fluff amount. The Rec. Bid field 

calculates the correct bid based on the percentage from your Cost of Goods table and 

incorporates the Fluff amount even though it is not displayed in the Parts tab. 

 

 

 

 

 

 

 

Handheld Devices 

 

● Private Comments for parts can now be entered at the time of inventory when using the 

Pinnacle Inventory program. 

● The Pinnacle Inventory program will now show quantity-on-hand totals for the site and 

for all sites. Totals will display in the following manner: current site/all sites. 

● A new Find Parts button in the part entry screen of Pinnacle Inventory will bring up a 

search results screen for the part/interchange you are currently inventorying. 

● Fixed how the devices handle an ―UnknownError‖ message from the server. 

 

Please contact support to update Pinnacle Pad or Pinnacle Inventory to the latest version. 
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 Report Enhancements & Fixes 
 

A1 Customer Payments 

● Fixed an issue where the report had incorrect totals when a payment was allocated to an 

invoice twice (e.g. a $500 payment, $250 allocated to invoice #1234, then another $250 

allocated to invoice #1234). 

 

A2 Sales Transaction Report 

● Improved speed of report generation. 

 

A5 Accounts Receivable 

● When exporting into Excel from the Summary tab, the statement columns will now 

appear in the correct order. 

● Improved speed of report generation. 

● The 2 Stmt now shows the correct amount when printing from the Summary tab. 

● Fixed an issue where different accounts with identical names were combined when 

printing the list from the Detail tab. 

 

A9 Customer List 

● The Sales Person attached to an account in the Customer Screen will now show on this 

report. The report can also be ordered by the Sales Person. NOTE: the View must be 

changed to either Customers Only or Account Customers Only for the grouping to work. 

 

A11 New/Lost Customers Report 

● The phoneid field was added to the Excel export. The phoneid matches the pblink field 

in the dataviews. 

 

A13 Customers at Risk Report 

● The phoneid field was added to the Excel export. The phoneid matches the pblink field 

in the dataviews. 

 

Advertising Source Pop-up Report 

● The Sales Amount no longer includes tax in the totals. 

 

B10 Top Parts 

● Cores sales are no longer included in the number of sales for an interchange 

 

B11 Part Puller Commission Report 

● Fixed an issue where if a part was marked as processed and then removed from the 

workorder, a tally would no longer appear on the report. The fix applies retroactively—

i.e. reports from previous date ranges can be re-run and the numbers will be corrected. 

● Fixed issue where report would generate an error if not using departments. The report can 

now be run even if there are no departments used in the workorder manager. 

 

B12 Dismantlers Report 

● Fixed issue where dismantled vehicles with no dismantled parts (i.e. vehicles with only Y 

parts inventoried) would still show on the report. 
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Parts Puller Detail 

● Fixed an issue where if a part was marked as processed and then removed from the 

workorder, the log entries for the workorder manager activity would no longer appear on 

the report. The fix applies retroactively—i.e. reports from previous date ranges can be re-

run and appropriate log entries will appear. An entry saying ―Deleted‖ will appear when 

an item is removed from a workorder. 

 

Dismantling Schedule 

● If a vehicle was crushed, would cause an error. This is now fixed so the error does not 

occur and a prompt comes up asking if you are sure you want to dismantle the vehicle: 

 
 

PinPad Bid Report 

● wording changed on report to match the field names in Pinnacle Pad. 

 

S11 Daily Reconciliation 

● Unallocated payments will now show the user that received the payment. 

 

S13 Sales by Customer Category 

● Changed the column labels to more clearly reflect the totals that are shown. The columns 

now read: Total Sales, Sales Tax 1, Sales Tax 2, Gross Sales, Gross Credits, and  Net 

Sales. NOTE: Total Sales is the gross invoice total without tax. 

 

T7 Parts Sold 

● Tag # is now included when exporting the report to Excel 

● Fixed an issue where if a part had a cost and was credited, the credit would show up 

twice if done within the date range of the report. 

● The Stock No. column has been changed to Stock No./PO No.. All brokered parts now 

list the PO number in that column instead of the BP001 stock number. 

 

T8B Detail Over Stock Report 

● Corrected inaccuracies occurring on the end of the report in the summary totals and 

averages. NOTE: the Stan. Price total is the total of the standard price for all parts, 

which can be compared to the Price total, which is the total of the actual price for all 

part, to compare if the parts are generally over- or underpriced. Additionally, the Stan. 

Price average includes all interchanges where the standard B price has been set 

(including interchanges where the standard B is set to 0). 

 

Jim Counts Management Assistance Reports 

● Sales Report 
- Now shows the percentage each salesman does in each sales category (i.e. inventory, 

brokered, warranty, etc…) 


